Copyright Notice

This manual describes software that contains published and unpublished works of authorship proprietary to EZCAM Solutions, Inc. It is made available for use and maintenance of our products. Under copyright laws, this manual, or the software it describes may not be copied in whole, or in part, without prior written consent of EZCAM Solutions, Inc., except in normal software use. The information in this document is subject to change without notice and should not be construed as a commitment by EZCAM Solutions, Inc.

All software package identifying names appearing herein prefaced with EZ are trademarks of EZCAM Solutions, Inc., All Rights Reserved.

EZ-CAM® and any other references to EZCAM applications software are protected by

Copyright 1999-2002 of EZCAM Solutions, Inc.
All Rights Reserved.

Printed Documentation
Copyright 1999-2002 of EZCAM Solutions, Inc.
All Rights Reserved.
Welcome

This chapter is an instructional guide intended for users with little or no experience in EZ-EDM operations. The two exercises in this chapter step through the entire process of creating NC programs for the sample parts.

EDM Tutorial 1: Standard 2D Machining

EDM Tutorial 2: Advanced 4-Axis Machining

Throughout the tutorial you will find important notes, tips or references to the online help where additional information on the commands and functions is provided.

The following steps are explained in detail:

- Geometry creation in EZ-EDM
- Create the path curves
- Create the Part program (define Work Steps to machine the part)
- Posting the NC code
CHAPTER 4

**Basic Programming Steps**
Before we continue with the tutorials let us explain the basic steps needed to create a part program with EZ-EDM.

**STEP 1. Create Geometry**
Start by creating part geometry via commands under the Geometry Menu.

**STEP 2. Define Path Curves**
Use the “Curves” menu commands like CHAIN, ARC, LINEAR, etc. to define curves by tracing or chaining existing geometry.

**STEP 3. Create Work Steps and set Machining Parameters**
Define Work Steps for each machining operation and apply the parameters as required by type of operation. Assign the desired path curve to each Work Step. Visualize the computed wire path to assure correct operation and proper setting of machining parameters.

**STEP 4. Post G-Code**
Select the “Postprocessor” related to the type of control and let the software create the G-Code file.

All EZ-EDM tutorials are completely set up in Inch with all Inputs and Dimensions in Inch!

**EDM Tutorial 1 (2D Contour Machining)**
The drawing of EDM Tutorial1 is shown in Picture 4-1. It is a simple 2D part that would be cut using the standard contouring cycle. The following tutorial discusses each of the steps necessary to machine the part in detail.
Blueprint of EDM Tutorial 1

Picture 4-1
DEFINING ORIGIN, WINDOW SIZE AND LOCATION

The window size is the distance from the edge of the window to the center of the window. The window location is the signed, absolute position of the window center from the part’s origin. The viewing parameters that are found in the Setup dialog box specify the size and location of the window. Note that you would not normally perform this step in programming a part, but it is necessary here to insure clarity in following the tutorial. Normally, you would just use the Zoom/Fade commands to set the window size as needed.

When selecting the origin for the part, choose a location that is referenced by the part’s dimensions. The origin should be selected before defining the window location (see next topic for setting up the workspace), because the window center is referenced from the part’s origin. The graphic in Picture 4-2 below shows the location of the part origin for this exercise (X = 0, Y = 0).
SETTING PREFERENCES

Before continuing with the construction of the tutorial sample part, several parameters should be set so that the system is compatible with the instructions in this tutorial. Also the size of the workspace should be set. The sample part is about 3-inch in the X-axis and 1-inch in the Y-axis. Because of the size of the part, it is not convenient to work in the default window; therefore, the window and some default settings have to be changed.

1. Select "New" command from the “File” menu to restart EZ-EDM and to clear the memory before continuing with the tutorial. Press OK to start over.

2. Select "Setup" command from the “View” menu

3. Type “0” for “X Center”, “0” for “Y Center” and “1.5” for “Size”. This sets the window size from the edge of the window to the center of the window, allowing enough room to see all of the part as it is created. See Picture 4-2.

4. Select “Inch” option button as the parts input dimension system.

5. Click the “Background” list box and select “White”.

6. Check the box "Blank Verify". This will cause verified wire paths to be blanked when the view is changed or the screen is redrawn.

7. Check the box "Save as Default". The system will store all dialog settings as defaults for future sessions.

8. After the preferences have been correctly set, click OK.
The initial setup for the first EDM Tutorial is now complete. Continue with the next section to create the geometry necessary for this part.
**The Part Geometry**

Now that the view port has been adjusted to accommodate the part, the creation of the part can begin. This involves creating geometry that is used to define the wire paths for machining the part. The geometry is created first, so that the process of creating the wire paths is greatly simplified.

Part geometry is necessary because it creates guidelines to follow when defining the wire path. The geometry used in this tutorial is fairly simple. It consists mainly of several lines and arcs. There are many ways to create the geometry required for this part. The method chosen for this tutorial demonstrates the use of several tools available within the geometry menu. Since this part is symmetrical across the Y axis, the geometry for one side of the part will be created, and then mirrored across the Y axis to create the other half.

If it's not already the case, click the “X-Y View” button to change the view to X-Y

**Creating Circles**

1. Click the “Circle/Arc, Center, Radius” command from the geometry toolbar.

2. For the Radius of the first circle, type “0.125” in the “R” field of the Value Entry Box. You will see the “preview” circle on the screen when you move the mouse.

3. Use the TAB key to move to the “X” field. Type “1.5 – 0.125” for the Center X location, then press Tab again to move to Y field.

4. Type “0” for the Center Y location. Then click the ENTER button and the first circle will be drawn at the desired location.
6. For the next circle move back to the “X” field and enter “0.25” for the new Center X location.

7. Move to “Y” field and Type “0.875 - 0.125”, then press ENTER. The second circle will be created. See Picture 4-3.

![Picture 4-3](4-8 EZ-CAM)

**CREATING CONNECTED LINES**

The geometry for the base and small foot are created next. This is accomplished by a series of connected lines using location points that can be found from the part blueprint in Picture 4-1.

1. Click the “Connected Lines” Icon from the geometry toolbar.

   ![Connected Lines](4-8 EZ-CAM)

2. Click the cursor into the “X” field of the Value Entry Box. Enter “0” for the X coordinate of the first endpoint. Use TAB key to move to the “Y” field and enter “0” for the Y coordinate. Press ENTER and the start point of the first Line is displayed at the axis origin.
3. Input “1” for the X coordinate and “0” for the Y coordinate of the endpoint. Then press ENTER and the Line is drawn on the screen.

4. Keep “1” for the next X coordinate, and change Y coordinate to “-0.125”. Press ENTER and the second Line is displayed.

5. Enter “1.125” for the next X coordinate, and keep “-0.125” for the next Y coordinate. Press ENTER and the third Line is displayed.

6. Keep “1.125” for the next X coordinate and change Y coordinate to “0”. Press ENTER and the fourth Line is displayed.

7. Enter “1.5” for the next X coordinate, and keep “0” for the next Y coordinate. Press ENTER and the fifth Line is displayed.

The geometry just created should appear as in Picture 4-4 shown below.
Creating Lines at Angle

The next step in creating the geometry is to define the angled lines at the outer edge of the part. These lines are created tangent to the already existing circles.

1. Select the “Line at Angle” command from the Geometry toolbar. This command creates a Line at a specified angle to a selected Line, and through a selected point. In this case the selected Line will be the Y axis, and the point is the tangency point on the circle.

2. Move the cursor to the Y axis of the coordinate system until the dynamic preview will display a Line on the Y axis. Then click with the left mouse button. This will select the Y axis as reference axis for the angular input.

3. Click the cursor into the A (angle) field of the Value Entry Box and Type “3” (don’t press ENTER).

4. Select the Tangential Point command from the Snap Mode toolbar. Position the cursor as shown in Picture 4-5 and click the mouse to select the circle.

Picture 4-5
The next step is to define the second angled line at the outer edge of the part. This line is created similar to the last one.

1. Select the “Line at Angle” command from the Geometry toolbar.

2. Move the cursor to the X axis of the coordinate system until the dynamic preview will display a Line on the X axis. Then click with the left mouse button. This will select the X axis as reference axis for the angular input.

3. Click the cursor into the A (angle) field of the Value Entry Box and Type “–3” (don’t press ENTER).

4. Select the “Tangential Point” icon from the Snap Mode toolbar. Position the cursor as shown in Picture 4-6 and click the mouse to select the circle.

![Picture 4-6]
TRIMMING OF ELEMENTS

The lines just created need to be trimmed. This is accomplished using the “Remove to Closest” command.

1. Select the “Remove to Closest” command from the Geometry Edit toolbar. This command will remove sections of the selected element that lie between the nearest intersection points with other elements. The cursor position will decide which part of the element is removed.

2. Move the cursor to the positions shown in Picture 4-7 and click to trim the Lines. When finished, the geometry should appear as in Picture 4-8.
**Creating Parallel Lines**

The next step is to define a Line, parallel to the Y axis.

1. Select the “Line Parallel” command from the Geometry toolbar. This will create Lines parallel to a selected Line or to one of the coordinate system axis.

2. Click the cursor into the D (Distance) field of the Value Entry Box and Type “0.25” (don’t press ENTER).

3. Move the cursor to the right side of the Y axis until the dynamic preview will display a Line parallel to the Y axis. Then click with the left mouse button to create the Line. See Picture 4-9.
**CREATING LINE, TWO POINTS**

The next step is to create a Line by defining start- and endpoint.

1. Click the “Line, two Points” Icon from the geometry toolbar.

2. Click the cursor into the “X” field of the Value Entry Box. Enter “0” for the X coordinate of the first endpoint. Use TAB key to move to the “Y” field and enter “0.19” for the Y coordinate of the first endpoint. Press ENTER and the first point is displayed.

3. Input “0.25” for the X coordinate and keep “0.19” for the Y coordinate of the next endpoint. Press ENTER and your Line will be on the screen.

![Picture 4-10](image-url)
Again there is some trimming necessary to remove parts of some of the elements.

1. Select the “Remove to Closest” command from the Geometry Edit toolbar.

2. Click the cursor at the positions shown in Picture 4-11. For the result see Picture 4-12.
CHAPTER 4

COPY / MIRROR GEOMETRY

Next step is to mirror the existing geometry across the Y axis.

1. Select the “Symmetry / Across Y-Z Plane” command from the “Edit” menu or the corresponding icon if available in one of the toolbars.

   ![Mirror Y-Z Plane]

2. Select the “Copy Mode” command from the Group Edit toolbar or the “Edit” menu, activate the “Make 1 Copy” option and press OK.

   ![Copy Mode]

3. Make sure that the “Verify Mode” is active. This can be accomplished by a mouse click on the “Verify Mode” Icon in the Group Edit toolbar. The mode is active when the icon is displayed in the “pressed” condition.

   ![Verify Mode]

4. Select the “Snap All” pick mode from the SNAP Mode toolbar and select the center of the coordinate system as the base point through which the YZ symmetry plane axis is running.

   ![Snap All]
5. Now you have to select the geometry elements that should be mirrored. Clicking each single element can do this. The fastest way of course is to select them all at once by placing a selection box around all of them. Place the cursor to POS 1 shown in Picture 4-14. Hold the left mouse button down and drag it to POS 2. You will see a box changing its size with every cursor movement. On this point release the mouse button and press ENTER. Now your geometry should appear as in Picture 4-15.
DELETING ELEMENTS

To show you how to delete elements we will remove some lines in the middle area of the part.

1. Select the “Delete” command from the Group Edit toolbar.

   ![Delete]

2. Make sure that the “Verify Mode” is active. This can be accomplished by a mouse click on the “Verify Mode” Icon in the “Group Edit” toolbar. The mode is active when the icon is displayed in the “pressed” condition.

   ![Verify Mode]

3. Click on the positions / elements shown in Picture 4-16. The selected elements are highlighted. At the end press ENTER to confirm the delete action. As a result your picture should appear as in Picture 4-17.
**CREATING LINE, TWO POINTS**

Next thing is to create two new lines to complete the geometry again.

1. Select the “Line, two Points” command from the geometry toolbar.

![Line, two Points](image)

2. Select the “Snap All” pick mode icon from the SNAP Mode toolbar.

![Snap All](image)

3. Click on the positions shown in Picture 4-18. First #1 and #2, then #3 and #4. The geometry is complete again.

![Picture 4-18](image)
**CREATING CIRCLE TO SIMULATE START POINT**

The last part of the creation of the part geometry is to define a circle to simulate and display the wire start point.

1. Click the “Circle/Arc, Center, Radius” command from the Geometry toolbar.

2. For the Radius of the circle, type “0.02” in the “R” field of the Value Entry Box. You will see the “preview” circle on the screen when you move the mouse.

3. Use the TAB Key to move to the “X” field. Type “0” for the Center X location, then press Tab again to move to “Y” field. Type “-0.095” for the Center Y location.

4. Press ENTER to confirm the input. See Picture 4-19 for the result.

If you want to save the newly created geometry before continuing, jump to the “Save Part Program” section at the end of Tutorial 1.
**The Path Curves**

Before we continue with the path curve creation we give you a short explanation about what a path curve is. Each Work Step needs a profile or shape the wire will have follow in some way. Therefore a path (curve) has to be assigned to every Work Step following certain rules determined by the selected machining cycle (Contour, Pocketing, etc). For example it is allowed to define an open path when using the “Contour” cycle, whereas a “Pocketing” path has to be closed.

A curve can be a straight line, an arc, a spline, or a combination of these things. It may include "rapid" moves, or it may be a single point. The curve does not have to follow any specific rules on its own, but as mentioned above, certain rules determined by the desired operation and the selected machining cycle have to be followed.

You have to assign a unique ID to each curve that is created. You may use your own ID’s or the systems defaults (Crv1, Crv2, etc.), but when working on extensive projects it is always good to use ID’s that can be easily remembered and that reflect the purpose of the curve.

**Important!**
Don’t use space or any other special characters in the curve ID.

---

**Create the Path Curve (Tutorial 1)**

Now we create the curve that will be later used as the wire path

1. Select “New” command from the “Curves” toolbar. A dialog with a prompt for a new curve name will be opened. Use the default “Crv1” and press OK to continue.
The new curve name is displayed in the “Curve Status” button at the bottom of the EZ-EDM window. Every curve creation or editing command only affects the curve displayed here.

2. Select the “Chain” curve command from the “Curves” menu and double click on the position shown in Picture 4-20. The geometry will be chained in clockwise direction, but since we will use “Start/End” command as the next step, curve direction or curve start point are not important at this stage.
**Defining Start / Endpoint**

Final step of wire path creation is to define the Start/Endpoint where the wire starts and ends machining. This function is only applicable when you machine a closed shape. In the case of an open profile, you may include the Lead-In and Lead-Out moves manually by defining them as part of the geometry / curve or automatically with the special options in the machining dialog.

1. Select “Start/End” command from the curve toolbar or the “Curves” menu. In the message bar, just below the Curve Status bar, “Pick Link” will be displayed. Move the cursor to the linear curve element as shown in Picture 4-21. The element will be displayed in dotted style. Now click with your left mouse button to select this particular element as the start element of the current curve.

2. After you selected the curve’s start element you need to define the position where the wire should start machining (also wire “thread” position). As we’ve already created a circle in that position, you can select the “Center Arc/Circle” snap mode icon and click the small circle as shown in Picture 4-22 with your left mouse button. The system automatically adds perpendicular approach and retracts to the curve.
Newly created "Lead-In" and "Lead-Out" Moves

**Important**

The default curve direction for female parts (Start/End point inside) is counter-clockwise, for male parts (Start/End point outside) clockwise. These directions correspond to the offset direction Left (G41). If desired you can reverse the direction anytime using the “Reverse Direction” command from the “Curves” menu.

The curves are stored in the same file as the geometry. Jump to the “Save Part Program” section at the end of the Tutorial 1 and select “Geometry” file type if you want to save all the data that has been created so far.
CREATING THE PART PROGRAM

Now we come to the third step in the programming sequence. We need to tell the EDM software how to machine the wire path curve. To keep the Part Program for Tutorial 1 fairly simple, we will define only two machining segments. Target control will be a Fanuc with modern options such as automatic wire “Thread / Cut”, corner control, etc. Although the software is able to calculate the offset wire path, we will use the automatic radius compensation for this example because it is commonly used in the field whenever possible. You will also see the definition of “FEED” and “COMP-REG” Register values. These settings and the way they are output in the final program depend on the type of control and the postprocessor in use. You will find more information about that subject in the corresponding section of the online help system.

The purpose of the first Work Step is to perform three passes along the outside shape of the part to get the desired surface finish.

1. Automatic “Wire Thread” command is created at the machining start.

2. The software generates three passes using the reverse cutting strategy, automatically changing offset and technology registers as well as offset direction for each of the subsequent passes. Passes No 1 and 3 will stop and retract the wire 0.3” before the end of the curve with a “Lead-Out” move of 0.05-inch. This move is necessary to change the registers and offset direction. At the end of the third pass the program will stop at the end of the Lead-Out move.

3. Program “STOP” command is created at the end of the first segment so that the part can be fixed before the following “Cut-Off” Work Step. Machinist fixes the part to prevent it from dropping down onto the lower nozzle during cut off.

The second Work Step also contains three cuts for achieving the final accuracy along the cut-off area.

1. First pass performs Cut-Off with Program “STOP” command to remove the part.

2. Next two passes are for desired surface finish.

3. Automatic “Wire Cut” command is created at the end of machining.
CREATING WORK STEP #1 (CONTOURING + STOP)

The purpose of the first segment is to perform three passes along the outside shape of the part to get the desired surface finish. The software will apply these passes using the reverse cutting strategy, automatically changing Offset and Generator registers and offset direction for each of the subsequent passes.

In addition a “STOP” command is created at the end of the Work Step so that the part can be fixed before the subsequent “Cut-Off” step. This enables the operator to fix the part to prevent it from dropping down onto the lower nozzle during cut off.

1. Select the “Data” command in the “Machining” menu to open the “Work Step Data” dialog. Once it is open switch to the “Cutting Data” tab.

2. Press the “New” button and press OK to select the system default Work Step ID “Seg1”.

3. Select “Contouring” from the cycle list.

4. Now you have to select the curve you want to machine in this Work Step. As there is only one curve so far it is automatically selected for machining. You can check this by the fact that its name is displayed in the “Segment Curves” table. If you have more than one curve, click on the “Add” button and select one or more curves from the list on the dialog that is displayed then. In case you have selected the wrong curve, simply highlight it again using the cursor and click the “Remove” button.
5. Input “0” for Z-Contour (program plane) and “Guide Upper”. Then “-1” for “Thickness” (of work piece) and “Guide Lower”. The last value is negative because the program plane is located on the upper edge of the work piece with the part lying below in negative Z direction. This setting is important for wire path simulation, especially when applying taper angles. See Picture 4-23.

![Work Step Data](image)

Picture 4-23

6. Input “1”, “2”, and “3” in the corresponding cells of “Feed” and “Comp-Reg” columns. They are used for outputting generator (S) and offset-register (D) codes for Fanuc or similar controls. These settings depend on the material type, height of work piece, cutting conditions or user defined machining strategies. See Picture 4-23.
7. Select the “Cycle Data” tab and ensure that the parameters listed below are set correctly. See Picture 4-24.

- **Offset Dir.:** Left
  Specifies offset direction for automatic wire compensation (G41, G42, G40). Set to “Left” because our example is a male part with the machined curve defined in clockwise direction.

- **No Passes:** 3
  The software will apply these passes using the reverse cutting strategy, automatically changing Offset and Generator registers and offset direction for each of the subsequent passes. Passes No 1 and 3 will stop “0.3” (Stop Length) before the end of the curve with a 0.05-inch (Lead Out Length) lead out move that is needed to switch registers and offset direction. After of the third pass the program will stop at the end of the lead out move.

- **Auto Path:** Retract
  The software will retract the wire at a given “Stop” distance (Stop Length) before the end of the machined curve(s).

- **Wire Comp:** ON
  Automatic cutter (wire) compensation (G41, G42, G40) will be used in the machine program. Compensation will be activated on “Lead-In” and cancelled on “Lead-Out” moves automatically.

- **Auto Wire:** Thread
  This will output a Wire thread command at the beginning of the first machining segment (only necessary for machines with automatic wire thread/cut option).

- **Stop Length:** 0.3
  The “Stop Length” and “Overlap” settings are directly related to the “Auto Path” option. The wire will stop 0.3-inch before the part is cut off. At this point the wire will be retracted using the “Lead Out” and “Out-Angle” settings.

- **Lead Out Length:** 0.05 / Out Angle:** 90
  These values specify length and angle of the automatic lead out move that is applied at the “Stop” position.
8. Select the “Toolpath Options” tab and ensure that the parameters listed below are set correctly. Close the dialog using the “Close” button. See Picture 4-25.

- **Taper Status**: OFF
  
  No taper output is used for this tutorial.

- **Show Taper**: ON (checked)

  This enables 3D viewing of the work piece in isometric, XZ or YZ views even if there is no taper angle applied.
9. Switch to “Isometric View” and select the “Verify” button to calculate and display the wire path on the screen as shown in Picture 4-26.

The Work Step #1 is now complete. Hit the “Redraw” button to refresh the screen and remove the verified wire path display.
**CREATING WORK STEP #2 (CUT-OFF)**

This Work Step is used to create the “Cut-Off” sequences.

1. Click the Work Step Data button to open the “Work Step Data” dialog. Once it is open switch to the “Tool Info” tab.

   ![Work Step Data](image)

2. Press the “New” button and press OK to select the system default Work Step ID “Seg2”.

   ![Work Step ID](image)

3. Select “Contouring” from the cycle list.

   ![Work Step Data](image)

4. Select the “Cycle Data” tab and ensure that the parameters listed below are set correctly. See Picture 4-27.

   - **Auto Path**: Revrs Cut

   Machining the same curve as in the first Work Step, this parameter will automatically create the “Cut-Off” sequence and cutting off the part before retracting the wire to the curve start.

   It is very important to use the same “Offset Dir”, “Stop Length”, “Lead Out Length” and “Out Angle” settings as in the previous Work Step because these settings specify the start position when using “Revs Cut” (Reverse Cut Off) option.
Auto Wire : Cut
This will output a Wire cut command at the end of the Work Step.

5. Click the “Verify” button to calculate and display the wire path on the screen as shown in Picture 4-28.
The Work Step #2 is now complete. Hit the “Redraw” button to refresh the screen and remove the verified wire path display.
3D SOLID PREVIEW

One of the most powerful EZ-CAM features is the 3D solid preview function. This function shows an animated tool cutting a solid model of the programmed part. Once the simulation is finished or interrupted by the user pressing “Esc” key, all dynamic view commands to rotate, zoom or move the simulated model on the screen are available. If no “Stock Setup” has been defined when the “Preview 3D” command is called, the system automatically calculates the “Stock” size, according to the maximum calculated wire movements. For the tutorial we will manually assign the stock size using the “Stock Setup” dialog that can be opened from the “Machining” menu.

1. Select the “Stock Setup” command from the “Machining” menu and input the values as shown in Picture 4-29. Close the dialog with OK.

![Picture 4-29]

2. Before starting the preview select the “Isometric View” command. Then start the simulation using “Preview 3D” command from the “Machining” menu or the corresponding button. The “Hide Peace” command can be used to toggle between the solid bodies resulting from the cutting process. See Picture 4-30.
3. Once the simulation stopped you can change the on-screen view by using the dynamic view commands (Rotate, Pan, Zoom) from the “View / Dynamic Viewing” menu.

**Picture 4-30**

3. Once the simulation stopped you can change the on-screen view by using the dynamic view commands (Rotate, Pan, Zoom) from the “View / Dynamic Viewing” menu.

**Picture 4-30**
**SAVING THE PART**

It is very important to save the newly created or edited part from memory to disk periodically during a session as well as at the end to ensure that no information is lost. The EZ-CAM “Save” and “Save as” commands under the File menu transfer files from system memory to a hard disk or other media. In EZ-EDM, the part information is stored in two different types of files, the “Part” file using the extension "PRT" and the associated “Geometry” file with extension "GEO". This flexibility allows the user to load an existing part file to be used with newly created geometry and path curves.

<table>
<thead>
<tr>
<th>File Type</th>
<th>GEOMETRY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension</td>
<td>GEO</td>
</tr>
<tr>
<td>Data</td>
<td>Geometry Elements (lines, arcs, etc.), Curves, User-Coordinate Systems (UCS)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File Type</th>
<th>EDM4X 2D PART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension</td>
<td>PRT</td>
</tr>
<tr>
<td>Data</td>
<td>Work Step Data (Technology &amp; Machining Information)</td>
</tr>
</tbody>
</table>

There is no specific rule what should be saved first. Of course, if there is only one kind of data in memory (Work Steps or Geometry) the “Save as” dialog will automatically open with the correct file type.

![Save As Dialog](Picture 4-31)
1. Select “Save as” command from the “File” menu.

2. Select the appropriate drive and folder where the geometry and part files should be stored. You can use the “EZCAMW \ EDMPARTS” folder that was automatically created by the setup routine.

3. Select “Geometry (*.GEO)” from the “Save as type” list box to store the geometry data.

4. Type the new filename “Edm-Tutorial1” in the “File Name” box and click the “Save” button. The file extension is added automatically.

5. To store the machining information (Work Step Data) select “EDM4X 2D Part (*.PRT)” from the “Save as type” list box and click “Save” again.

If you have already saved the geometry, the software automatically inserts a part file with the same name but different extension (*.PRT) in the “Save” menu when the first Work Step is created. All you have to do is to select “Save All” option from the “File” menu or the corresponding toolbar button.

The software will save and overwrite the existing files without any screen prompt. You can use this command anytime for fast saving of your work.
**Creating CNC Code**

Now that the part program has been created, it must be converted to run on a NC control by running the “Post” command with the appropriate “Post-Processor” for your machine.

The CNC data file or “Post-Processor” is used as a "template" to format the part program data file that was created in EZ-Turn. This template consists of program formats (e.g., TOOL CHANGE, LINEAR MOVE, RAPID MOVE, etc.) that determine the structure of a part program for a specific CNC. To create or edit a “Post-Processor” a special editor called “EBuild” is required.

1. Select “Post” command in the “Machining” menu. This will open the “Post Process” dialog.

![Post Process dialog](Picture 4-32)
2. First a postprocessor has to be loaded. If the one desired is already loaded and displayed in the section “CNC-File” continue to the next step. Otherwise use the “Change” button to browse your system for a different postprocessor.

Standard postprocessor directories created by the EZCAM setup:

**INCH**

<DRIVE>:\EZCAMW\EDM13\EDMINCHPOST

**METRIC**

<DRIVE>:\EZCAMW\EDM13\EDMMETRICPOST

3. Select the “Screen” option in the “Listings” section. The computed program text will be displayed on the screen.

4. Activate (check) the “EZ-DNC” option. This will automatically start the “EZ-DNC” application when posting of the part file is finished and load the newly created file for sending it to the machine using the serial port. See Chapter 6 “Communication with the Control” for more information about EZ-DNC.

5. Next is the “G-Code File” section. Here the default name and directory for the computed program file is displayed. The name is taken from the part file that was saved before. The default directory is “EZCAMW\EDMGCODE”.

   ![Info]

   Ensure that part file and postprocessor share the same dimension unit (“Inch” for this tutorial). The system will generate a “Dimension Unit Conflict” message, but then automatically scale the NC-Code according to the dimension specified in the postprocessor.

   See online help for more information about the “Setup” dialog located in the “View” menu.

6. Click the “Post” to start posting. The Processing window will be displayed showing messages followed by listings of ASCII code created. When all Work Steps have been processed, a final message dialog box is shown. See Picture 4-33.
6. Click OK to close the message dialog box. To close the Processing window click [X] at the top right-hand corner of the window.

Congratulations! You've completed the EDM Tutorial 1!
EDM TUTORIAL 2 (XYUV MACHINING)

The second EDM tutorial steps through the entire process of creating an XYUV program for the part shown in Picture 4-51. It is recommended to read and complete the first tutorial before attempting this tutorial.

This is not a particularly useful part to cut, however, it is a good example of a part that is cut with a four-axes machining strategy. It requires only one machining segment to define the separate paths for the XY and UV planes. Details of this segment are described later in this tutorial.

Picture 4-51
**Defining Origin, Window Size and Location**

The window size is the distance from the edge of the window to the center of the window. The window location is the signed, absolute position of the window center from the part’s origin. The viewing parameters that are found in the Setup dialog box specify the size and location of the window. Note that you would not normally perform this step in programming a part, but it is necessary here to insure clarity in following the tutorial. Normally, you would just use the Zoom/Fade commands to set the window size as needed.

When selecting the origin for the part, choose a location that is referenced by the part’s dimensions. The origin should be selected before defining the window location (see next topic for setting up the workspace), because the window center is referenced from the part’s origin. The graphic in Picture 4-52 below shows the location of the part origin for this exercise (X = 0, Y = 0).
**SETTING PREFERENCES**

Before continuing with the construction of the Tutorial 2 sample part, several parameters should be set so that the system is compatible with the instructions in this tutorial. Also the size of the workspace should be set. The sample part is about 6-inch in both axes. Because of the size of the part, it is not convenient to work in the default window; therefore, the window and some default settings have to be changed.

1. Select "New" command from the “File” menu to restart EZ-EDM and to clear the memory before continuing with the tutorial. Press OK to start over.

2. Select "Setup" command from the “View” menu

3. Type “0” for “X Center”, “0” for “Y Center” and “3.0” for “Size”. This sets the window size from the edge of the window to the center of the window, allowing enough room to see all of the part as it is created. See Picture 4-52.

4. Select “Inch” option button as the parts input dimension system.

5. Click the “Background” list box and select “White”.

6. Check the box "Blank Verify". This will cause verified wire paths to be blanked when the view has changed.

7. Check the box "Save as Default". The system will store all dialog settings as defaults for future sessions.

8. After the preferences have been correctly set, click OK.
The initial setup for the second EDM Tutorial is now complete. Continue with the next section to create the geometry necessary for this part.
CHAPTER 4

THE PART GEOMETRY

Now that the view port has been adjusted to accommodate the part, the creation of the part can begin. This involves creating geometry that is used to define the wire paths for machining the part. The geometry is created first, so that the process of creating the wire paths is greatly simplified.

X-Y View

If it’s not already the case, click the “X-Y View” button to change the view to X-Y

CREATING LINE, TWO POINTS

The first step is to create a Line by defining start and endpoint.

1. Click the “Line, two Points” command from the geometry toolbar.

2. For the first point click the cursor into the “X” field of the Value Entry Box. Enter “-2” for the X coordinate. Use TAB key to move to the “Y” field and enter “2” for the Y coordinate of the first endpoint. Press ENTER to confirm the coordinates.

3. Input “2” for the X coordinate and keep “2” for the Y coordinate of the second point. Press ENTER and your Line will be drawn on the screen as shown in Picture 4-54.
**COPY / ROTATING GEOMETRY**

Next step is to copy and rotate the line around the center of the “World” coordinate system. For this we first have to select the appropriate command, specify number of copies and rotation center and then select the geometry element(s) to be copied/rotated.

1. Select the “Rotate / Around Z Axis” option from the “Edit” menu or the corresponding icon if available in one of the toolbars.

2. Select the “Copy Mode” command from the “Edit” menu and input “5” in the “Number of copies” field. Select OK to close dialog. The “Copy Mode” icon will be displayed in “pressed” condition.

3. Make sure that the “Verify Mode” is active. The mode is active when the icon is displayed in the “pressed” position.

4. The rotation center is defined next. Click the cursor into the “X” field of the Value Entry Box. Enter “0” for the X coordinate and “0” for the Y coordinate of the rotation center. Move the cursor to the A (Angle) field and input “60” for the rotation angle. Press ENTER to continue.
5. Now you have to select the geometry element(s) to be rotated. Click on the single existing line to select this element. Press ENTER and the line will be rotated / copied as shown in Picture 4-55.

![Diagram showing rotated line](Picture 4-55)
**INSERTING CORNER FILLETS**

The next step is to place fillets at the corners of the hexagonal shape. This is done using the “Corner Fillet” command in the “Geometry” menu.

1. Select the “Corner Fillet” command from the “Geometry” menu or the corresponding icon.

![Corner Fillet Icon](image)

2. Input “0.375” in the “R” field of the Value Entry Box.

![Value Entry Box](image)

3. Move the cursor to the positions shown in Picture 4-56. The dynamic preview shows the fillet radius in the corner next to the cursor position. Just click when the preview shows the fillet at the desired position.

![Cursor Positions to insert the Fillets](image)

**Picture 4-56**
**Creating Circle**

Now we create the circle for the upper contour

1. Click the “Circle/Arc, Center, Radius” command from the “Geometry” menu or the toolbar.

2. For the Radius type “1.75” in the “R” field of the Value Entry Box. You will see the “preview” circle on the screen when you move the mouse.

3. Use the TAB key to switch to the “X” field. Type “0” for the Center X and “0” for the Center Y location.

4. Press ENTER and the circle will be drawn as shown in Picture 4-57.

![Picture 4-57](image-url)
**ADDING LINE TO MATCH START OF XY AND UV PROFILES**

Now we will add a line that will later help us to match the entry position of the XY and UV curves.

1. Click the “Line, two Points” command from the “Geometry” menu / toolbar.

   ![Line, two Points](Image)

2. Select the “Snap All” mode icon from the snap mode toolbar and click the center of the coordinate system for the first point of the line. See POS.1 in Picture 4-58.

   ![Snap All Mode](Image)

3. Select the “Mid Point” pick mode and click nearby the midpoint of the upper line. See POS.2 The new line is drawn as shown in Picture 4-58.

   ![Mid Point](Image)

---

**Picture 4-58**
MATCHING POINTS OF XY AND UV CONTOURS

At a later stage two curves have to be created to specify the wire path for a four-axes XYUV cycle. One for the UV upper profile and one for the XY lower profile. The points on both curves have to be matched so that the wire cuts along corresponding moves on each path. Otherwise, the finished part may take a “twisted” look.

Following two rules in defining the curves can help preventing this kind of error. First, make sure that the same numbers of points exist in both curves. The system will automatically correct for an unequal number of points using its auto matching function, however, this may introduce undesired effects. The second rule is to make sure that the points are spaced evenly along each path. This tutorial shows one way to accomplish this.

CREATE MATCHING LINES

1. Click the “Line, two Points” command from the “Geometry” menu / toolbar.

   ![Line, Two Points]

2. Select “Snap All” from the pick mode toolbar and click the center of the coordinate system for the first point of the first line. See POS.1 in Picture 4-59).

   ![Snap All]

3. Now click on the position POS.2 as shown in Picture 4-59 and the first line will be drawn.

4. For the second line, first click at POS 1, then at POS 3.
COPY / ROTATING GEOMETRY

Next step is to copy and rotate the lines around the center of the “World” coordinate system.

1. Select the “Rotate / Around Z Axis” option from the “Edit” menu or the corresponding icon if available in one of the toolbars.

2. Select the “Copy Mode” command from the “Edit” menu and input “5” in the “Number of copies” field. Select OK to close dialog. The “Copy Mode” icon will be displayed in “pressed” condition.
3. Make sure that the “Verify Mode” is activated. This can be accomplished by a mouse click on the “Verify Mode” icon in the Group Edit toolbar. The mode is active when the icon is displayed in the “pressed” condition.

4. To define the rotation center click the cursor into the “X” field of the Value Entry Box. Enter “0” for the X coordinate and “0” for the Y coordinate. Input “60” to the A (Angle) field as the rotation angle. Press ENTER to continue.

5. Now you have to select the geometry elements to be rotated. Use the cursor to click the two newly created lines. Press ENTER and the highlighted Lines will be rotated/copied as shown in Picture 4-60.
TRIMMING OF ELEMENTS

As the next step, the Lines that were just rotated should be trimmed to get a better picture of the part. This step is technically not necessary, but recommended for better visualization.

1. Select the “Remove to Closest” command from the “Geometry / Edit Line, Arc or Circle” menu or the corresponding icon on one of the toolbars. This command will remove sections of the selected geometry element that lie between the nearest intersection points with other elements. The cursor position will decide which part of the element is removed.

2. Move the cursor to the positions shown in Picture 4-61 and click to trim the Lines. See Picture 4-62 for the result.
CREATE XY PATH CURVE (LOWER CONTOUR)

Now we first create the curve that later represents the lower contour (XY plane).

**Important**
Both curves must include approach and retract moves. This can be done manually by defining linear moves at beginning and end of the curves or by using the “Start/End” function in the “Curves” menu. This is important because first and last moves are disregarded during automatic matching of upper and lower curves.

1. Select “New” command from the Curve toolbar. A dialog with a prompt for a new curve name will be opened. Use the default “Crv1” and press OK to continue.
The new curve name will also be displayed in the Curve status Bar at the bottom of the EZ-EDM window. Every curve definition or curve change command affects only the curve that is displayed here.

2. Select the “Arc Move” command from the “Curves” menu.

3. Select the “Snap All” icon from the pick mode toolbar and select the positions as shown in Picture 4-63 with the cursor. The connecting elements will be added to the curve, no matter if linear or arc moves.

Picture 4-63
DEFINING START/END FOR XY CURVE

Final step of lower wire path creation is to define the Start/End point. This function is only available on closed shapes. In the case of an open profile, you may include the Lead-In and Lead-Out moves manually by defining them as part of the geometry/curve or automatically with the “Ramp/Lead” options in the machining dialog.

1. Select “Start/End” command from the toolbar or the “Curves” menu. Use the cursor to select the “entry” curve element we want to start with as can be seen in Picture 4-64. The linear curve element will be displayed in dotted style.

![Start/End](image)

2. After selecting the “entry” curve element the “Pick new Start/End Point” message will be displayed. Select the “Snap All” icon and click at the center of the “World” coordinate system as shown in Picture 4-65. The system automatically adds perpendicular approach and retracts to the curve.

![Snap All Mode](image)
The default curve direction for female parts (Start/End inside the curve) is automatically set to counter-clockwise. For male parts (Start/End point outside) it is clockwise. These directions correspond to the offset direction “Left” (G41).

CREATE UV PATH CURVE (UPPER CONTOUR)

We now create the curve that later represents the UV upper contour.

1. Select “New” command from the Curve toolbar. A dialog with a prompt for a new curve name will be opened. Use the default “Crv2” and press OK to continue.

2. Select the “Arc Move” command from the “Curves” menu.
3. Select the “Snap All” icon from the pick mode toolbar and use the cursor to select the positions as shown in Picture 4-66.
DEFINING START/END FOR UV CURVE

Final step of upper wire path creation is to define the Start/Endpoint.

1. Select “Start/End” command from the toolbar or the “Curves” menu. Use the cursor to select the “entry” curve element we want to start with as can be seen in Picture 4-67. The arc curve element will be displayed in dotted style.

![Start / End](image)

Picture 4-67

2. When the start element has been selected the “Pick new Start/End Point” message will be displayed. Select the “Snap All” pick mode and click at the center of the “World” coordinate system as shown in Picture 4-68. The system automatically adds perpendicular approach and retracts to the UV upper curve.

![Snap All Mode](image)

Picture 4-68
**MOVING UV UPPER CONTOUR CURVE**

Next step is to move the upper contour curve to the desired Z position of 1.25 inch above the lower contour curve. This is because the software uses the curves Z positions to calculate corresponding Z data values for the machining operations. Before moving the upper curve we will switch the screen view to isometric. This gives you a real 3D feeling during the operation.

1. Select “Isometric View” option from the view toolbar or “View / View Control” menu.

![](Isometric View)

2. Select the “Move” option from the “Edit” menu or the corresponding icon from the toolbars. Using this option you will move elements from one defined position (Pick “from” point) to a new one (Pick “to” point).

![](Move)

3. Make sure that the “Verify Mode” is activated. This can be accomplished by a mouse click on the “Verify Mode” icon in the Group Edit toolbar. The mode is active when the icon is displayed in “pressed” condition.

![](Verify Mode)

4. Now we have to define the “Pick from point”. Select the “Snap All” icon from the toolbar and click on the center of the “World” coordinate system as shown in Picture 4-69.

![](Snap All Mode)
5. Next define the “Pick to point”. The X and Y field of the Value Entry Box should already display “0”. Click the cursor into the “Z” field and enter “1.25” as the new Z position for the upper contour. Press ENTER to confirm your input.

6. Now you have to select the element(s) you want to move. To make it easier activate the “Curve Discrimination” icon in the corresponding toolbar. Now screen selection is limited to curve entities.

7. Select the UV axis curve “Crv2” as in Picture 4-70 and press ENTER. See Picture 4-71 for the result.
If you want to save the newly created geometry and curves jump to the “Save Part Program” section at the end of Tutorial 2 and select “Geometry” file type.
**CREATING THE PART PROGRAM**

Now we have to tell the EDM software how to machine the two curves. To keep the part program of your first 4-axes XYUV tutorial simple, we will define only one machining Work Step. Target control will be a Fanuc with modern options such as automatic wire thread/cut, corner control, etc. Although the software is able to calculate the offset wire-wire path, we will use the machines automatic radius compensation for this example because it is commonly used whenever possible. You will also see the definition of “FEED” and “COMP-REG” registers. These settings and the way they are output in the final program of course strongly depend on the type of machine control and the postprocessor used.

The purpose of the Work Step is to perform one pass containing a program stop to fix the part before the cut-off.

1. Automatic “Wire Thread” command at the begin.

2. One pass (to STOP position) using the appropriate offset and generator registers.

3. Program “STOP” command is created before the end of the profile at “Stop-Length” distance. This enables the machinist to fix the part to prevent it from dropping down onto the lower nozzle during cut off.


**CREATING THE XYUV MACHINING WORK STEP**

To begin, open the machining dialog by selecting the Machining/Data menu or by pressing the button located next to the “Current Segment” button.

1. Click the Work Step Data button to open the “Work Step Data” dialog. Once it is open switch to the “Cutting Data” tab.
2. Press the “New” button and press OK to select the system default Work Step ID “Seg1”.

3. Select “XYUV” from the cycle list.

4. The “Segment Curves” list shows the curves that will be machined by the current Work Step. The last created curve is automatically loaded to this list by default. The hierarchical order of the curves listed here is very important when using the “XYUV” cycle. The curve ID listed first always specifies the lower (XY) contour while the second entry represents the upper (UV) contour. Therefore we first have to clear the list before assigning the curves in the correct order. Select “Crv2” and press the “Remove” button as shown below to clear the list.
5. Select “Add” button to open the “Add Segment Curves” dialog. It is very important that the XY lower contour curve will later be the first entry in the “Segment Curves” list box. Therefore select “Crv1” first and click the “Add” button. Repeat the action with “Crv2”. Close the dialog using the “Close” button.

6. Now click the “Auto” button. The system automatically fills the “Z-Upper / Guide Upper” and “Z Lower / Guide Lower” fields with the corresponding curve values. The Z coordinate of the first element in the XY (lower) curve is used for the “Z Lower / Guide Lower” settings while the Z coordinate of the UV (upper) curve is used for the “Z-Upper / Guide Upper” fields. See Picture 4-72.

If you intend to use the “Auto” function it is necessary to move the curves to the desired Z positions first.

Optionally you can leave both curves at the “Z0” plane and specify the “Z-Upper / Guide Upper” and “Z Lower / Guide Lower” settings manually.

7. Input “1” in the corresponding cells of “Feed” and “Comp-Reg” columns. They are used to specify technology (S) and offset-registers (D) for Fanuc and similar controls. These settings depend on the material type, work piece height, cutting conditions and user defined machining strategies. See Picture 4-72.
8. Select the “Cycle Data” tab and ensure that the parameters listed below are set correctly. See Picture 4-73.

- Offset Dir. : Left
  Specifies offset direction for automatic wire compensation (G41, G42, G40).

- Wire Comp : ON
  Automatic cutter (wire) compensation (G41, G42, G40) will be used in the machine program. Compensation will be activated on Lead-In and cancelled on Lead-Out moves automatically.
EZ-EDM TUTORIAL

- **Auto Wire**: ON
  This will output a wire “Thread” command at begin and “Cut” command at the end of the machining process.

- **Stop Length**: 0.5
  The system will output a “STOP” command 0.5 inch before the end of the profile to fix the part before it is cut off.

---

![Work Step Data](Picture 4-73)

**Picture 4-73**
**VERIFYING THE XYUV WIRE PATH**

At this point you have completed creation of the XYUV machining Work Step. To simulate wire movement use the “Verify” function in the “Machining” menu or just click the corresponding icon.

![Verify](image)

When switching to “XY” view and selecting “Verify” command again you will see the “STOP” position marked as a small rectangle.

![X-Y View](image)

**Picture 4-74**

![Stop Position](image)

**Picture 4-75**
3D SOLID PREVIEW

1. Select the “Preview 3D” command from the “Machining” menu or the corresponding button. The “Hide Peace” command can be used to toggle between the solid bodies resulting from the cutting process. See Picture 4-76. Simply use the button sequence shown below to get the same results.

![3D Solid Preview Diagram]

Picture 4-76

2. Once the simulation stopped you can change the on-screen view by using the dynamic view commands (Rotate, Pan, Zoom) from the “View / Dynamic Viewing” menu.

![Dynamic View Commands]
SAVING THE PART

1. Select “Save as” command from the “File” menu.

2. Select the appropriate drive and folder where the geometry and part files should be stored. You can use the “EZCAMW \ EDMPARTS” folder that was automatically created by the setup routine.

3. Select “Geometry (*.GEO)” from the “Save as type” list box to store the geometry data.

4. Type the new filename “Edm-Tutorial2” in the “File Name” box and click the “Save” button. The file extension is added automatically.

5. To store the machining information (Work Step Data) select “EDM4X 2D Part (*.PRT)” from the “Save as type” list box and click “Save” again.

It is not possible to save data when the software is running in evaluation (Demo) mode. The “Save” and “Save as” commands are disabled. Continue with the next step in the tutorial.
CREATING CNC CODE

Now that the part program has been created, it must be converted to run on a NC control by running the “Post” command with the appropriate “Post-Processor” for your machine.

1. Select “Post” command in the “Machining” menu. This will open the “Post Process” dialog.

2. First a CNC Data file, also referred to as Postprocessor, has to be loaded. The currently loaded Postprocessor is displayed in the “CNC-File” section. If this section is empty (nothing loaded) or you want to change to a different one, select the “Change” button. In the dialog then displayed, go to your directory where the postprocessors are stored on your system and select the one you need.

3. Activate (check) the “Screen” option. The computed program text will be displayed on the screen.
4. Next is the G-Code File” section. Here the default name and directory for the computed program file is displayed. The name is taken from the part file that was saved before. The default directory is “EZCAMW\EDMGCODE”.

5. Click the “Post” to start posting. The Processing window will be displayed showing messages followed by listings of ASCII code created. When all Work Steps have been processed, a final message dialog box is shown. See Picture 4-79.

6. Click OK to close the message dialog box. To close the Processing window click at the top right-hand corner of the window.

Congratulations! You’ve completed the EDM Tutorial 2!